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Look around your new Mac Pro

See the ports, connectors, and other features.

Take a tour of Mac Pro
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Configure your Mac Pro

Your Mac Pro has user-accessible memory, graphics modules, and expansion cards that are
user-upgradeable.

Configure your Mac Pro

Secure storage and secure boot

Built-in security features ensure your data is safe and your computer starts up only with
legitimate macOS software.

Secure storage and secure boot on your Mac Pro
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n Firmware password protection is off.

Turn on a firmware password to prevent this computer from starting up from a
g different hard disk, CD, or DVD without the password.

Turn On Firmware Password...
Secure Boot

t only your current OS5, or signed operating system software currently
trusted by Apple n run. This mode requires a network connection at software
installation
Medium rity
Allows any version of signed operating system software ever trusted by Apple to run,

* No Security
Does not enforce any requirements on the bootable O5.

Allowed Boot Media

external or re i
Restricts the abilit »ot from any devi d by the T2 such as USB and
Thunderbol ves or internally connected PCle or SATA drives.
Allow ting from al or rem a
Does not r

Stay in sync

Access your documents, photos, music, apps, contacts, and calendars across all your devices
with iCloud.

Access your iCloud content on your MacAccess your iCloud content

] 55555596000 |
|| 95959505050,
GOOSOO0080050050
SS0000000590950
G999509009699590
5500500550005000
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Mac Pro at a glance

NAV TITLE: Take a tour

Your Mac Pro is packed with advanced technologies.

Status 3.5 mm
Power, ,indicator light HDMI 2.0 headphone jack

10Gb Ethernet Thunderbolt 3 USB 3
(USB-C) (USB-A)

Latch Latch
Antenna Antenna
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'Thunderbolt 3 Status‘ ‘Power
(USB-C) indicator light button

e 3.5 mm headphone jack: Plug in stereo headphones or speakers to experience high-quality
sound while listening to music or watching movies. Or plug in an analog headset with a built-in
mono microphone to make audio and video calls.
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e USB 3 (USB-A) ports: Connect an iPad, iPhone, iPod, digital camera, external storage device,
or printer. The Mac Pro USB 3 ports support USB 3 and USB 2 devices at up to 5 Gbit/s.

e Thunderbolt 3 (USB-C) ports: Mac Pro has two Thunderbolt 3 (USB-C) ports on the front and
two ports on the back. If an Apple MPX Module is installed, it may have additional ports. Use
these ports to transfer data, and connect docking stations and RAID arrays. The ports support
displays if an Apple MPX Module is installed. The ports also support USB 3 with speeds up to
10 Gbit/s, and can charge devices, such as an iPad or a rechargeable trackpad or keyboard.

e Status indicator lights: One light is on the front of your Mac Pro next to the power button and
another is on the back, beside the power port. A steady white light indicates that your Mac Pro
is awake or in sleep; no light indicates that your Mac Pro is turned off.

Note: If there is a memory detection or data error, the status light is solid orange for 0.2
seconds and repeats every second. If the lights blink amber twice every two seconds, your
Mac Pro has a PCle configuration error. For more information, see the Mac Pro (2019) status
indicator behavior.

e HDMI 2.0 ports: Mac Pro can have one or more HDMI 2.0 ports, depending on its GPU
configuration. The ports can connect your Mac Pro to a TV or an external display.

e 10 Gigabit Ethernet (RJ-45) ports: Your Mac Pro has two 10 Gigabit Ethernet ports that can use
Nbase-T Ethernet technology, which supports multiple data rates for speeds up to 10 Gbit/s
over standard twisted-pair copper cable up to 100 meters (328 feet) in length. Depending on
the device you’re connecting to, the cable type and technology used, and the cable length, the
highest link speed is automatically negotiated. For example, if the device you’re connecting to
is 10 Gbit/s-capable and the cable can support that speed, the two devices negotiate the 10
Gbit/s speed.

See the following chart for connection speeds and cable types. Speeds are for cables up to
100 meters (328 feet) in length, unless otherwise specified.

(table aria-label=Supported Connection Speeds for Cable Types)

Cable Type 1 Gbit/s 2.5 Gbit/s 5 Gbit/s 10 Gbit/s

Category 5e 9 V) 9 Not supported

Category 6 9 9 o @ Up to 55 m (180
feet)

Category 6a (V] V] V] 9

e Power port: Plug the power cord into the power port on the back of your Mac Pro, then plug
the other end of the cord into a power outlet.

e Power button: Press to turn on your Mac Pro. Choose Apple menu ¢ > Shut Down to turn off
your Mac Pro, or choose Apple menu ¢ > Sleep to put it to sleep.

Connect accessories
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NAV TITLE: Work wirelessly

Work wirelessly

Using Bluetooth® technology, your Mac Pro can wirelessly connect (that is, pair) with devices
such as the included Magic Keyboard with Numeric Keypad, and with devices like the

Magic Mouse 2 and Magic Trackpad 2, AirPods, peripheral devices, wearable sports accessories,
and others. To connect your Mac Pro with a device that’s not already paired, choose Apple menu
& > System Preferences, then click Bluetooth.

Note: Your Magic Keyboard with Numeric Keypad and the optional Magic Trackpad 2 behave
like a wired keyboard and pointing device when connected using the included Lightning to USB-
C Cable. Bluetooth isn’t used, and all communication is over the cable.

See the next section, What’s included.

NAV TITLE: What'’s included

What’s included
To use your Mac Pro, you need two accessories included in the box—the Magic Keyboard with
Numeric Keypad and either the Magic Mouse 2 or Magic Trackpad 2.

Important: To begin using your Magic Keyboard with Numeric Keypad and Magic Mouse 2 or
Magic Trackpad 2, make sure the on/off switch of each device is on O™ (green is visible). The
devices connect to your Mac Pro automatically.

CDOOOO00O0000000000000

N 4

e Magic Keyboard with Numeric Keypad: Your rechargeable Magic Keyboard with Numeric
Keypad is already connected with your Mac Pro and is ready to use. When you need to charge
the keyboard or if you need to connect it again, connect it to your Mac Pro using the included
USB-C to Lightning Cable.
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To customize how your keyboard works, use the Keyboard pane of System Preferences.
Choose Apple menu & > System Preferences, click Keyboard, then click the buttons at the top
to see the options available for keyboard, text, shortcuts, and input sources. To learn what the
function keys on the keyboard do, see Keyboard.

e Magic Mouse 2: Like the Magic Keyboard with Numeric Keypad, your rechargeable
Magic Mouse 2 is already connected with your Mac Pro out of the box; you can use it
anywhere within range of your computer. When you need to charge the mouse or if you need to
connect it again, connect it to your Mac Pro using the included USB-C to Lightning Cable.

To customize your gestures, use the Mouse pane of System Preferences. Choose Apple menu
& > System Preferences, click Mouse, then click the buttons at the top to see all the scrolling,
clicking, swiping, and tapping options.

e Magic Trackpad 2: If you configured your Mac Pro with the optional Magic Trackpad 2, it comes
connected with your Mac Pro and is ready to use out of the box; you can use it anywhere
within range of your computer. When you need to charge the trackpad or if you need to
connect it again, connect it to your Mac Pro using the included USB-C to Lightning Cable.

To customize your gestures, use the Trackpad pane of System Preferences. Choose
Apple menu ¢ > System Preferences, click Trackpad, then click the buttons at the top to see
all the Point & Click, Scroll & Zoom, and Gestures options.

If you purchased a Magic Mouse 2 or Magic Trackpad 2 separately, connect it to your Mac Pro
with the included USB-C to Lightning Cable to use Bluetooth. Use this same cable to charge your
devices as necessary, then unplug them and use them in the location that works best for you.

NAV TITLE: Keyboard

Keyboard

The function keys on your Magic Keyboard with Numeric Keypad provide shortcuts for common
functions, such as increasing the volume or screen brightness.

Function keys (F1 to F12)l Function (Fn) key| D On/off switch|
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e On/off switch: Slide the on/off switch on the back edge of the keyboard to turn it on 0D (green
is visible) or off.

e Brightness keys (F1, F2): Press 36 or %: to increase or decrease the brightness of the screen.
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e Mission Control key (F3): Press 2,0 to view what’s running on your Mac Pro, including all your
spaces and open windows.

e [aunchpad key (F4): Press 333 to instantly see all the apps on your Mac Pro. Click an app to
open it.

e Media keys (F7, F8, F9): Press Qg to rewind, || to play or pause, or >p to fast-forward a song,
movie, or slideshow.

e Mute key (F10): Press ¢ to mute the sound from the built-in speakers or 3.5 mm headphone
jack.

e \olume keys (F11, F12): Press qy) or < to increase or decrease the volume of sound from the
built-in speakers or 3.5 mm headphone jack.

e Function (Fn) key: Each function key (on the top row) can also perform other functions. Hold
down the Fn key while you press a function key to trigger the action associated with the key.

Tip: Press the Fn key twice to turn on dictation, which lets you dictate text wherever you can
type it, such as in Messages, Mail, Pages, and many other apps. (Requires an external
microphone, which is sold separately at apple.com and your local Apple Store.)

Set keyboard preferences. Use the Keyboard pane of System Preferences (choose
Apple menu ¢ > System Preferences, click Keyboard, then click the buttons at the top to see the
available options).

Learn about keyboard shortcuts. You can press key combinations to do things on your
Mac Pro that you’d normally do with a trackpad, mouse, or other device. For a list of commonly
used keyboard shortcuts, see Keyboard shortcuts on your MacKeyboard shortcuts.

NAV TITLE: Mouse

Mouse
Here are some common gestures you can use with your Magic Mouse 2.

(table aria-label=Mouse gestures)

Gesture Action

Turn on/off: Slide the on/off switch on the bottom of the mouse to turn it on
QD (green is visible).

Click: Press the upper part of the mouse surface to click or double-click.
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Secondary click (that is, right-click): Press the left or right side of the
mouse to perform a “secondary click.” (Enable right- and left-click in System
Preferences @ > Mouse > Secondary click.)

360° scroll: Brush one finger along the surface to scroll or pan in any
direction.

Screen zoom: Hold down the Control key and scroll with one finger to
enlarge items on the screen. (Enable this feature in System Preferences @ >
Accessibility > Zoom > Use scroll gesture with modifier keys to zoom.)

Two-finger swipe: Swipe left or right to move through pages, photos, and
more.

EEDNENEY

Customize your gestures. To set preferences and enable gestures, choose Apple menu ¢ >
System Preferences (or click the System Preferences icon @ in the Dock), click Mouse, then click
the buttons at the top to see the available options.

NAV TITLE: Trackpad

Trackpad

You can do a lot on your Mac Pro using simple trackpad gestures—scroll through webpages,
zoom in on documents, rotate photos, and more. With the Force Touch trackpad, pressure-
sensing capabilities add another level of interactivity. The trackpad provides feedback—when you
drag or rotate objects, you feel a subtle vibration when they’re aligned, allowing you to work with
greater precision.

Here are some common gestures:
(table aria-label=Magic Trackpad gestures)

Gesture Action

Click: Press anywhere on the trackpad. Or enable “Tap to click” in Trackpad
preferences, and simply tap.

Force click: Click and then press deeper. You can use force click to look up
more information—click a word to see its definition, or an address to see a
preview that you can open in Maps.
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Secondary click (that is, right-click): Click with two fingers to open
shortcut menus. If “Tap to click” is enabled, tap with two fingers.

Two-finger scroll: Slide two fingers up or down to scroll.

Pinch to zoom: Pinch your thumb and finger open or closed to zoom in or
out of photos and webpages.

Swipe to navigate: Swipe left or right with two fingers to flip through
webpages, documents, and more—like turning a page in a book.

Open Launchpad: Quickly open apps in Launchpad. Pinch closed with four
or five fingers, then click an app to open it.

Swipe between apps: To switch from one full-screen app to another, swipe
left or right with three or four fingers.

Customize your gestures. Choose Apple menu ¢ > System Preferences or click the System
Preferences icon @ in the Dock, then click Trackpad.

In Trackpad preferences you can:

e [ earn more about each gesture

e Set the click pressure you prefer to use

e Decide whether to use pressure-sensing features
e Customize other trackpad features

Tip: If you're force clicking when you don’t intend to, try adjusting the click pressure to a firmer
setting in Trackpad preferences. Or change the “Look up and data detectors” option from the
“Force Click with one finger” default setting to “Tap with three fingers.”

For examples of force click options, see the Apple Support article How to use the Force Touch
trackpad.

NAV TITLE: Charge the battery

Charge the battery

Your Magic Keyboard with Numeric Keypad, Magic Mouse 2, and Magic Trackpad 2 each have a
built-in rechargeable battery.

Charge the battery. Connect your Magic Keyboard with Numeric Keypad or Magic Mouse 2 (or
optional Magic Trackpad 2) to your Mac Pro with the included USB-C to Lightning Cable. To
check the charge level, click 3 in the menu bar at the top of the screen, then choose the device.
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If you don’t see the Bluetooth icon in the menu bar, choose Apple menu ¢ > System Preferences
(or click the System Preferences icon @ in the Dock), click Bluetooth, then select “Show
Bluetooth in menu bar.”

See Disposal and recycling information or visit Apple Lithium-ion Batteries.

NAV TITLE: Adapters

The following Apple adapters are available to connect external devices, displays, and more, to
the Thunderbolt 3 (USB-C) ports on your Mac Pro.

(table aria-label=Adapters that can be purchased separately.)

Adapter Description

Thunderbolt 3 (USB-C) to Thunderbolt 2 Adapter: Connect your Mac Pro
= to Thunderbolt 2 devices or a Thunderbolt display.

USB-C Digital AV Multiport Adapter: Connect your Mac Pro to an HDMI
device, while also connecting a standard USB device.

USB-C VGA Multiport Adapter: Connect your Mac Pro to a VGA projector
or display, while also connecting a USB device to your Mac Pro.

_ USB-C to USB-A Adapter: Use a USB-C port to connect your Mac Pro to a
USB-A device.

USB-C to SD Card Reader: Insert an SD card to transfer high-resolution
E photos and videos to your Mac Pro.

For a full list of suitable adapters, see the Apple Support article Adapters for the Thunderbolt 3
(USB-C) or USB-C port on your Mac or iPad Pro.

Adapters and other accessories are sold separately. Visit apple.com, your local Apple Store, or
other resellers for more information and availability. Review the documentation or check with the
manufacturer to make sure you choose the right product.

NAV TITLE: Connect a display
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The Thunderbolt 3 (USB-C) ports # support video output when an Apple MPX Module graphics
card is installed. (A third-party GPU doesn’t enable video on Thunderbolt 3 (USB-C) ports 4.) The
HDMI 2.0 port on your Mac Pro also supports video. You can use an external display, a projector,
or an HDTV with your Mac Pro.

Note: Mac Pro has at least one HDMI 2.0 port and four Thunderbolt 3 (USB-C) ports. The
Thunderbolt 3 (USB-C) ports on your Mac Pro are managed by two controllers—one controls the
two ports on the front of Mac Pro and one controls the two ports on the I/O card on the back of
the computer. There are additional controllers and HDMI ports if Apple MPX Module graphics
cards are installed.

(table aria-label=Connect to an external display.)

To connect this device to Mac Pro Use a cable, or an adapter and cable

Thunderbolt 3 (USB-C) display Thunderbolt 3 (USB-C) cable

USB-C display USB-C (USB 3.1) cable

HDMI display or HDTV The HDMI cable that came with your display or HDTV
Thunderbolt 2 display Thunderbolt 3 (USB-C) to Thunderbolt 2 adapter and the

cable that came with your Thunderbolt 2 display

VGA display or projector USB-C VGA Multiport adapter and the cable that came
with your display or projector

DisplayPort or Mini DisplayPort display USB-C to DisplayPort cable, or DisplayPort or Mini
DisplayPort adapter and the cable that came with your
display

DVI display or projector USB-C to DVI adapter and the cable that came with your

display or projector

Adapters and other accessories are sold separately. Visit apple.com, your local Apple Store, or
other resellers for more information and availability. Review the documentation or check with the
manufacturer to make sure you choose the right product.

Install Mac Pro into a rack

NAV TITLE: Install Mac Pro into a rack

Install Mac Pro into a rack
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Important: Before installing Mac Pro into a rack, read the safety notes found in
Important safety information for your Mac.

Mac Pro and the rail assemblies can be installed into any of the three industry standard rack
types. The rails come assembled to fit into square holes, but if you remove the outer nut, the rails
fit into round hole racks. To install into a threaded rack, remove the screws from the rails, then
replace the screws to secure the rails to the rack. This requires a standard 3mm (1/8-inch) hex
wrench and a 6mm (1/4-inch) wrench. Examples of the different types of rack are below.

Square hole rack

|— No tools required.

Round hole rack

Use a 1/8-inch hex wrench.

Threaded rack
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Use a 1/8-inch hex wrench.

Use a 1/4-inch wrench.

Use a 1/8-inch hex wrench.

To install Mac Pro into a rack, you need to attach the rail assemblies to Mac Pro and the rack.
The minimum depth of the rack must be at least 24 inches; the maximum depth should be no
more than 42 inches.

Note: Mac Pro requires five rack units (5U). The top two units should be left vacant, the rail
assemblies should be installed in the next two units, and one unit below the rail assemblies
should be left vacant.

I.—i a—
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0 2U
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O — 5U space needed for entire unit
2U (Rails fit here) Q
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Air to cool Mac Pro flows from front to back. Make sure nothing blocks any of the openings in the
front and back of the housing.
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2. Insert the assembly’s rear rail pins into the back of the rack, then pull the assembly to lock it
into place.

3. Insert the assembly’s front rail pins into the front of the rack, then push the assembly to lock it
into place.

The assembly should snap into place.
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— Front rail pins

4. Slide out the inner rail until it locks.

[T

The release latch is located
on the outside surface of the rail.

6. Repeat steps 1 to 4 for the other rail assembly.

7. Attach the inner rails to the sides of Mac Pro, making sure that the release latches are towards
the front of the computer and the rail eyelets are well placed onto the Mac Pro rail posts.
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Rail posts

8. Slide the rail section forward until the spring lock engages the forward post.

Forward rail post

9. With one person on each side, lift Mac Pro.
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10. Align the rails attached to Mac Pro with the middle rails in the rack, then slide the computer
into the rack. Ensure the locking latches are fully engaged.

Remove Mac Pro from a rack

Follow these steps to remove Mac Pro from a rack.
1. Move both locking latches down to the unlocked position.

2. Slide out the computer until it stops.

Latches

3. With one person on each side, safely hold Mac Pro.
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then remove Mac Pro from the rack.

4. Pull the orange release latches on both rails

-

Release latch

-
e

then

Note: You can detach the rails from the side of Mac Pro by pulling the spring latch forward

sliding the rail back.

Spring latch
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Remove Mac Pro rails from a rack

Follow these steps to remove Mac Pro rails from a rack.

1. If the inner rail is extended, pull the orange release latch, then slide the rail in.

The release latch is located
on the outside surface of the rail.

2. Push in the rear orange latch at the back of the rail, then push the assembly back to unhook
the rear pins.

Rear orange latch

3. Open the latch at the front of the assembly to release the front pins, then lift the assembly out
of the rack.

Get started
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NAV TITLE: Set up your Mac

Set up your Mac

The first time you turn on your Mac Pro, Setup Assistant walks you through the simple steps
needed to start using your new Mac Pro. If you want to transfer your data from another computer,
see Transfer your dataTransfer your data to your new for details.

Welcome
In just a few steps, you can register and set up your Mac,

T

United States
Canada
United Kingdom
Australia
New Zealand
Iraland
Singapore

Show All

Back Continue

Be sure to connect your Mac Pro to Ethernet or Wi-Fi, turn on Bluetooth® wireless technology,
get an Apple ID, then sign in to your device.

Sign in with your Apple ID. Your Apple ID is the account you use for everything you do with
Apple—including using the App Store, the iTunes Store, iCloud, Messages, and more. Your
Apple ID consists of an email address and a password. You need only one Apple ID to use any
Apple service, on any device—whether it's your computer, iOS device, iPadOS device, or
Apple Watch. It’s best to have your own Apple ID and not share it.

If you don’t already have an Apple ID, you can create one during setup (it’s free). To manage your
Apple ID, go to the Apple ID account website.

If other family members use Apple devices, make sure that each family member has their own
Apple ID. You can create Apple ID accounts for your kids and share purchases and subscriptions
with Family Sharing. See Apple Account on MacApple Account.

Important: If you forget your Apple ID password, you don't need to create a new Apple ID. Just
click the “Forgot Apple ID or password?” link in the sign in window to retrieve your password.

You can do the setup tasks quickly and easily with Setup Assistant—but if you want to do them
later, here’s how:

Choose light or dark appearance. If you want to change the choice you made when you set up
your Mac, click the System Preferences icon @ in the Dock, or choose Apple menu ¢ > System
Preferences. Click General, then select Light, Dark, or Auto for your appearance. You can also set
other appearance preferences here.
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Connect to Wi-Fi. Click the Wi-Fi status icon = in the menu bar, then choose a Wi-Fi network
and enter the password, if necessary.

Turn Wi-Fi on or off. Click the Wi-Fi status icon = in the menu bar, then choose Turn Wi-Fi On
or Turn Wi-Fi Off.

Turn Bluetooth on or off. Click the Bluetooth icon R in the menu bar, then choose Turn
Bluetooth On or Turn Bluetooth Off.

Tip: If you don’t see the Wi-Fi status icon = or Bluetooth icon 3} in the menu bar, you can add
them. For Wi-Fi, choose Apple menu ¢ > System Preferences, then click Network. Click Wi-Fi in
the list on the left, then select “Show Wi-Fi status in menu bar.” For Bluetooth, choose

Apple menu ¢ > System Preferences, click Bluetooth, then select “Show Bluetooth in menu bar.”

Set up iCloud on your Mac Pro. With iCloud, you can store all of your content—documents,
movies, music, photos, and more—in the cloud, and access it anywhere you go.

To set up iCloud, choose Apple menu ¢ > System Preferences. Sign in with your Apple ID if you
haven’t already. Click Apple ID > iCloud, then select the features you want to use. To find out
more, see Access your iCloud content on your MacAccess your iCloud content.

Important: Be sure to sign in with the same Apple ID on all your devices.

Find your way around

NAV TITLE: The desktop, menu bar, and Help

The first thing you see on your Mac Pro is the desktop, where you can quickly open apps, search
for anything on your Mac Pro and the web, organize your files, and more.
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Apple menu The desktop Finder window Siri

Help menu IMenu bar = Wi-Fi icon|

Ve
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Finder icon

System Preferences icon Dock

Tip: Can’t find the pointer? To magnify it temporarily, slide the mouse back and forth quickly.

Menu bar. Use the menus and icons along the top of the screen to open new windows, connect
to a Wi-Fi network, check your Wi-Fi status =, change the volume «»), query Siri, and more. The
menu items change, depending on which app you’re using.

Apple menu g. The Apple menu in the upper-left corner of the screen contains frequently used
items. To open it, click the Apple icon ¢.

Help menu. Help for your Mac Pro and apps is always available from the Finder. To get help,
click the Help menu and choose macOS Help to open the macOS User Guide. Or type in the
search field and choose a suggestion.

| ®& Finder File Edit View Go Window

To learn more, see macOS User Guide.

Use a Dynamic Desktop. When you use a Dynamic Desktop picture, you can watch your
desktop picture automatically change to match the time of day in your current location. Choose
Desktop & Screen Saver in System Preferences, then select the Dynamic setting. To have your
screen move from day to night based on your current time zone, enable Location Services. If
Location Services is turned off, the picture changes based on the time zone specified in Date &
Time preferences.

Stay organized with stacks. To create stacks on your desktop, go to Finder and choose View,
then select Use Stacks. To see options for your stacks, go to View > Group Stacks By. Then any
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new files you add to the desktop are automatically sorted into the appropriate stack. To view
what’s inside a stack, click the stack to expand its contents. You can also place your cursor over
a stack to view file thumbnails. To learn more, see Organize files in stacks on Mac in the macOS
User Guide.

Stay focused with Dark Mode. Use a dark color scheme for the Desktop, menu bar, Dock, and
all the built-in apps on macOS. Your content stands out front and center while darkened controls
and windows recede into the background. See white text on a black background in apps such as
Mail, Contacts, Calendar, and Messages, so it’s easier on your eyes when you’re working in dark
environments.

HOOERANOBEANOP - QLTEAT =

Dark Mode is finely tuned for professionals who edit photos and images—colors and fine details
pop against the dark app backgrounds. But it’s also great for anyone who just wants to focus on
their content.

Keep reading to learn about The Finder on your MacThe Finder and other features of the desktop.

NAV TITLE: The Finder

Use the Finder to organize and locate your files. To open a Finder window, click the Finder icon &
in the Dock at the bottom of the screen.
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Sync devices. When you connect a device like an iPhone or iPad, you can see it in the Finder
sidebar. From there you can back up, update, and restore your device.

Gallery View. With Gallery View, you can see a large preview of your selected file, so you can
visually identify your images, video clips, and other documents. The Preview pane shows
information to help you identify the file you want. Use the scrubber bar at the bottom to quickly
locate what you’re looking for. To close or open the Preview pane, press Shift-Command-P.
Tip: To show filenames in Gallery View, press Command-J and select “Show filename.”
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Gallery View

Scrubber bar

Quick Actions. At the bottom right of the Preview pane are shortcuts that let you manage and
edit files directly in the Finder. You can rotate an image, annotate or crop an image in Markup,
combine images and PDFs into a single file, trim audio and video files, or create custom actions
through Automator workflows (for example, watermarking a file). To learn more, see Perform quick
actions in the Finder on Mac in the macOS User Guide.

To show the Preview pane options in the Finder, choose View > Show Preview. To customize
what’s shown, choose View > Show Preview Options, then select the options for your file type.

Tip: Select a file and press the Space bar to open Quick Look. You can sign PDFs; trim audio
and video files; and mark up, rotate, and crop images without opening a separate app. To learn
more about Quick Look and markup features, see View and edit files with Quick Look on Mac and
Mark up files on Mac in the macOS User Guide.

NAV TITLE: The Dock

The Dock, at the bottom of the screen, is a convenient place to keep the apps and documents
you use frequently.

Go to the Finder. Open System Preferences.

MOPOIREBOBERNO0 - QAL THAD

Apps in your DockI Recently opened apps

Files, folders, and Trash
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Open an app or file. Click its icon in the Dock. Recently opened apps appear in the center
section of the Dock.

Add an item to the Dock. Drag the item and drop it where you want it. Place apps in the left
section of the Dock, and files or folders in the right section.

Remove an item from the Dock. Drag it out of the Dock. The item isn’t removed from your
Mac Pro—just from the Dock.

Tip: You can make the Dock larger or smaller, add or remove items, move it to the left or right
side of the screen, and even set it to hide when you’re not using it. To change how the Dock
looks, click the System Preferences icon @ in the Dock, or choose Apple menu ¢ > System
Preferences. Then click Dock.

Learn more. See the Apple Support article Use the Dock on Mac.

NAV TITLE: Quickly open apps

Your Mac Pro comes with apps for all the things you love to do—browse the web, check email,
share photos, enjoy movies, and more.

Launchpad arranges your apps in a grid.
Folder containing apps Click an app icon to open it.

=) "

AOOLIRGRBOBOBNOF - QATHEZT WY

Launchpad icon App Store icon

Open an app. Click an app icon in the Dock, or click the Launchpad icon & in the Dock, then
click the app you want. You can also search for an app using Spotlight, then open the app
directly from your Spotlight search results.

Organize apps in Launchpad. Launchpad organizes your apps in a grid. Drag an app to a new
location to rearrange apps. Drag an app onto another app to create a folder. Drag more apps to
the new folder to add them. To remove an app from a folder, drag it out.



